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About This Training Guide 

TRAINING GUIDE DESCRIPTION 

This training guide covers the use of IBM Maximo, a web-based Inventory Management application that 

simplifies the overall processes of tracking, managing and ordering of consumable inventory. The 

purpose of this training is: to help users collect, consolidate and analyze essential inventory information, 

to improve operations through better inventory availability, reliability and utilization, to unify processes 

for inventory management functions across multiple sites, and to reduce inventory costs and control 

spending. 

TRAINING GUIDE OBJECTIVES 

In this training guide, you will: 

 Review the navigation features in Maximo 

 Review some of the foundational concepts and functionality in Maximo 

 Explore proper setup and configuration of the Inventory database 

 Explore the tasks and processes involved in Inventory Management 

 Explore proper setup and configuration of the Inventory purchasing 

 Explore the tasks and processes involved in Inventory purchasing and receiving 

 Review the standard and custom reporting tools available in Maximo 

 Review the Asset Management features available 

 Review the Work Order Tracking features available 
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1. Navigation Refresher 

Learning Objectives 

In this lesson, you will: 

 Review the Inventory – Item Master application 

 Review the Inventory – Inventory application 

Lesson Overview 

The Maximo software application is a web-based package with a consistent look and feel that helps 

users be more productive. The Start Center is configurable, and applications that users work with often 

can be accessed easily from anywhere in the program. In this lesson, users will review some of the 

navigation paths and features that will be used every day. 

1.1. Navigation Review: Item Master 

One way to search or view the items in the database is by querying the Inventory – Item Master 

application. As with most main areas of Maximo, the Item Master is available in the Go To menu located 

in the Top Menu at the top of the Start Center. 

ACTIVITY 1.1 

Review the Navigation Options on the Item Master Application 

Scenario 

You want to review the navigation, options, and layout on the Item Master application. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 
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Steps 

A. Navigate to the Item Master application. 

1. In the Top Menu, click Go To. 

 

2. In the dropdown menu, hover over Inventory to display the Inventory sub menu. 

3. In the sub menu, click Item Master. The Item Master application is displayed. 

 

B. Explore the Item Master application. 

1. The Item Master application has several ways to filter and sort the Items that are displayed. 
At the top left, select the List of Saved Queries (top left corner/non name field) dropdown 
menu. 

2. Select All Records. 

 

3. Observe the Item column on the left of the Item Master application. 

4. In the Quick Find box at the top of the screen, enter AD-1052. 
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5. Press Enter. 

 

6. The Item tab for the Item selected is displayed along with the detailed information for the 
selected item. 

 

7. Click the Storerooms tab, the Storeroom Information displays the Storerooms that are 
associated with the currently selected Item. 

 

8. Click the Clear Changes icon.    The List tab is displayed again with no Items shown. 

C. Save a query. 

1. In the Description query field, enter filter##, where ## is your student number. 

2. Press Enter. 

3. Click Save Query. 
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4. In the Save Current Query dialog box, in the Query Name field, enter Description: Filter##, 
where ## is your student number. 

5. In the Description field, enter Filter##, where ## is your student number. 

6. Click Ok. 

 

7. Click the list of Saved Queries (top left corner/no name field) dropdown menu. 

8. Click Filter. 

9. Click Save Query dropdown menu. 

10. Click View/Manage Queries to find your query. 

11. Click on the Trash can icon to mark for deletion. 

 

12. Click OK. 

13. When you are finished, click Start Center in the Top Menu. 

1.2. Navigation Review: Inventory 

After reviewing the Items that are available on the Item Master application, one way to view the Items 

that are assigned to each Storeroom is to navigate to the Inventory – Inventory application. The 

Inventory application will display the quantity information for each Item in each Storeroom. 
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ACTIVITY 1.2 

Review the Navigation Options on the Inventory Application 

Scenario 

You want to review the navigation, features, and options on the Inventory application. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 

Steps 

A. Navigate to the Inventory application. 

1. In the Top Menu, click Go To. 

2. In the dropdown menu, hover over Inventory to display the Inventory sub menu 

3. In the sub menu, click Inventory. The Inventory application is displayed. 

 

B. Explore the Inventory application. 

1. In the list of Saved Queries (top left corner/no name field) dropdown menu, click All 
Records. All of the Items are displayed. 
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2. Click the Item header link to sort the Items ascending by Item code. 

 

3. Observe that some Items are located in multiple Storerooms and have varying Quantities 
Available. 

4. In the Item query field, enter AD-1052. 

5. Press Enter. The Item is displayed in the results. 

 

6. Click the Item to display the Inventory tab for that Item. 

C. Explore the Inventory tab. 

1. Observe that required fields are designated with an asterisk, and the field is highlighted. 

2. Click the Select Value icon (magnifying glass) for the Issue Unit field to display a list of 
measurement units used by the system. Some Items may be ordered by one unit (BOX) and 
issued by another (EACH). 
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3. Click Cancel to close the Select Value dialog window. 

4. On the Inventory tab, observe the Available Balance Summary information for the Item. 

5. At the bottom of the page, observe the Inventory Balances section. 

6. The Current Balance value and the Physical Count value may not be the same. 

 

7. Click inside the Physical Count field. 

8. Press Alt + F1, the Field Help is displayed. 

 

9. Observe that the Physical Count is the number of Items logged during the last physical count. 

10. Click Ok to close the Field Help dialog box. 

D. Explore the Reorder Details tab. 

1. Click on the Reorder Details tab. 

2. Observe the Reorder Details section on this tab. 

 

3. Observe Reorder Point field that defines when the reordering is prompted.  

4. Observe Economic Order Quantity field that provides the best economic ordering value.   

5. When you are finished, click Start Center in the Top Menu. 
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2. Foundational Knowledge 

Learning Objectives 

In this lesson, you will: 

 Identify key Maximo functionality 

 Review the integration features of the Arizona Financial Information System, ProcureAZ, and 
Maximo applications 

Lesson Overview 

This lesson is an introduction to some of the key features and functionality of the Maximo application 

platform. This lesson also introduces some of the integration features that have been configured 

between Maximo and other State applications: Arizona Financial Information System (AFIS) and 

ProcureAZ. 

2.1. Overview of Maximo Functionality 

Maximo is a web based platform that presents information in a consistent manner. While Maximo 

provides many modules and applications, navigation within and between applications is efficient and 

intuitive. Maximo helps inventory managers by providing optimized planning, control, audit, and 

compliance capabilities.  

Start Center 

The Start Center is a customizable dashboard. It serves as a Home Page and a central point for viewing 

key information such as performance indicators that monitor inventory balances and reorder points and 

trigger automated actions based on a changing database. Users can create, assign, notify, and report on 

key process components such as inventory stores, item supply levels, ordering metrics, and usage goals. 
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General Navigation 

After logging into Maximo, users can navigate using pages, menus, links, tabs and buttons. Each page 

has four main sections: 

 Header bar 

 Toolbar 

 Main tabs 

 Content 

 

The Go To menu can be used to navigate to any application that the user has access to. The Go To menu 

is a cascading menu that expands to multiple levels within each application. The keyboard shortcut for 

the Go To menu is Alt + G. The keyboard arrow keys can then be used to scroll through the menu and 

the Enter key used to select an application. 
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Online field help is available for all pages in Maximo by pressing Alt + F1 on the keyboard. The field help 

information provided defines how the field operates and helps guide data entry. 

 

The Help feature provides useful information on all aspects of Maximo functionality. The Help pages are 

searchable by keyword and navigated using links. 

Application Navigation 

Navigation is consistent throughout the applications in Maximo. Information is stored on various tabs 

that are listed in a logical order from left to right across the top of content section. Typically, selecting a 

record on the first tab (i.e. List); will determine what information is displayed subsequent tabs to the 

right similar to drilling down in a hierarchy. For example, selecting an Organization in the Organizations 

application will determine what addresses and sites are displayed on those tabs.  
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Select Records 

When working with a list of records in an application, by default, only one record is selected at a time. If 

multiple records must be selected, users can use the Select Records checkbox at the bottom of a list to 

display a checkbox next to each record on the left. The checkbox allows the user to select multiple 

records and perform actions on multiple records simultaneously using the Select Action menu at the top 

of the screen. The Select Records checkbox is only usable when 200 or fewer records are displayed. If 

more than 200 records are displayed, the filter fields can be used to reduce the number of records 

currently displayed. 

 

Select Action Menu 

The Select Action menu is a context sensitive menu that displays the available options for the current 

application and selected record. It is used to perform tasks such as adding items from the Item Master 

application to Storerooms. 

 

Security 

Maximo provides the ability to manage application security for users and groups. Only users with proper 

authority to access an area of the system will see it displayed. For example, users without security 

privileges to view an application will not see it displayed on the Go To menu. Security privileges and 

restrictions are definable for groups of users which makes managing application security easier. The 

security group to which a user is assigned also determines the Start Center template that the user sees 

when logging into the platform. Users that are assigned to more than one security group may see more 

than one tab in the Start Center, one for each security group. 
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Profile 

A user profile contains the user information specific to that user; this includes a password, contact 

details, and time zone. Several application defaults can be configured in the user profile. For example, 

the Default Insert Site can be set to the site from which the user most often inserts records and the User 

Default Application can be set to the application that displays when a user logs on to the system. 

 

Reports 

Maximo comes standard with many reports that cover many applications and include analysis, detail, 

hierarchical, and drill down reports. Reports can update the database, link to one another to provide 

more details, and refresh dynamically. Custom reports can also be created that include specific fields, 

custom grouping and sorting, or use unique report parameters. Reports can be run once or saved and 

scheduled to be run automatically. The contents of reports can be downloaded/exported to other file 

formats for additional analysis.  
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2.2. Inventory Integration 

The State of Arizona uses several applications to meet various business needs. Each application serves a 

separate defined purpose while working together to improve efficiency and increase productivity. 

Arizona Financial Information System (AFIS) is a financial management platform. ProcureAZ is a 

procurement management system that is used to manage and maintain vendor and purchasing 

information. Maximo interfaces with both of these applications in several important ways. 

Maximo/AFIS Integration 

AFIS is the financial platform used by the State of Arizona to maintain all accounting information. The 

Chart of Accounts (COA) is a foundational element in AFIS that determines where and how funds are 

used. When improper COA elements are used, AFIS generates system errors that control the input of 

information. The COA information and errors from AFIS are integrated into Maximo which help to 

control user input.  

In Maximo, when inventory items or costs are issued/returned to storerooms and transferred between 

storerooms, an accounting document is created and interfaced to AFIS. These documents are processed 

and approved automatically. 

Refer to Appendix B to view the flowchart. 

Maximo/ProcureAZ Integration 

ProcureAZ is used to create and manage vendors and purchase orders. When inventory items need to 

be ordered in Maximo, a request to create a Purchase Order (PO) is sent to ProcureAZ. Once the PO is 

created and approved in ProcureAZ, it is interfaced back to Maximo and used to update the PO. When 

inventory items have been received, a Receipt is processed in Maximo and interfaced to ProcureAZ. The 

interface builds the ProcureAZ receipt that is used for Invoice processing for payment. 

Refer to Appendix B to view the flowchart. 
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3. Setup and Configuration 

Learning Objectives 

In this lesson, you will: 

 Review the setup and configuration of Inventory 

 Identify the State Process for creating storerooms, items, and inventory 

 Create a new Storeroom record 

 Create a new Item record 

 Add an item to a storeroom 

Lesson Overview 

This lesson focuses on the proper setup and configuration of storerooms, item master lists, and 

inventory in the Maximo database. Within the Inventory module, there are several applications that 

work together to provide a way to track inventory throughout the State and its agencies. The 

Storerooms application is used to add and maintain information about storeroom locations and the 

items they contain. The Item Master application is used to define the items that can be stocked in 

storerooms. The Inventory and Inventory Usage applications are used to store information about all 

aspects of inventory materials and track the issue, transfer, and return of inventory items within and 

across agencies. 

3.1. Inventory Setup 

Proper setup and configuration of storerooms requires that some initial steps are completed in the 

Administration module, Organizations application.  

Administration Module 

The applications in the Administration module are used by system administrators to configure and 

maintain organizations, and groups of organizations called sets. In order to create and manage 

storerooms and inventory, the organizations and sites need to be configured in the Administration 

module, Organization application.  
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Organizations Application 

The Organizations application is used to set up the organizations and sites that are used by the State of 

Arizona and its agencies. For each organization, administrators can specify the following properties: 

 Base currency 

 Default item status 

 Item and company sets 

 General ledger clearing account 

 Address codes for organizational units and sites 

Organizations and sites are logical divisions within the State. The divisions are determined by the types 

of operations that are performed at different locations, and what data can be shared among them. 

Organizations are a major division that contains one or more sites. Sites that belong to the same 

organization share the same options for work orders, assets, and other types of data. Sites can track 

inventory and other data separately from other sites; certain types of information are unique to a site 

and are not visible to other sites within an organization. 

The List tab is used to view, filter, and select an available organization. 

 

The Organization tab is used to view the detailed information for the organization record selected on 

the List tab. 
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The Addresses tab is used to view, create, and modify the addresses for the organization record selected 

on the List tab. 

 

The Sites tab is used to view, create, and modify the sites associated with the organization record 

selected on the List tab. The Sites tab is also used to associate available address records with each site. 
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The Organizations application is used to set defaults for various options for other applications in 

Maximo, such as Work Order Tracking, Inventory, and Assets. These options are accessed from the 

Select Action menu. When setting certain application options, if a site is selected, the application setting 

applies at the site level; otherwise it applies at the organization level. 

 

Generally, the configuration of organizations, addresses, and sites will be done by system 

administrators. When selecting values for these fields in other applications, clicking the Magnifying Glass 

icon will allow users to view the available values in a list.  

 

Inventory Module 

The Inventory Module is a collection of applications for inventory management. These applications work 

together to help users maximize the availability of items for upcoming work tasks and reduce excess 

inventory balances and related carrying costs. 

The goal of inventory managers is to find a balance of inventory stock such that work can be performed 

with minimal delays due to unavailable materials while limiting the amount of inventory that is stored 

on site to what is needed. 
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The tasks involved in inventory management include the following: 

 Add and maintain storeroom locations and items stocked within a storeroom  

 Track items in stock 

 Identify when stock falls below user-defined reorder points 

 Create purchase requests and purchase orders to restock items 

 Report on items received 

 Define items for stocking in storerooms 

 Perform issues, returns, and transfers 

 Build a master list of condition codes for a particular item set 

Storerooms Application 

Storerooms are created and maintained in the Storerooms application in Maximo. Once a Storeroom 

has been created in the database, users can view the items that are stocked in the storeroom. The setup 

of a storeroom also involves associating the storeroom with the General Ledger information that is used 

to track the accounting for the storeroom. Users can define the lead time calculation for items in a 

storeroom and flag the storeroom to function as an internal supplier to other storerooms. 

Storerooms can be designated as the default storeroom for a site through the Storerooms application. 

The first storeroom created in a site becomes that site’s default storeroom.  
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Control Accounts 

The Storerooms application has two control accounts, one for items and one for tools. The general 

ledger control account is used for inventory items and the tool control account applies to tools. Creating 

a storeroom allows for the specification of a general ledger and tool control account. The general ledger 

control accounts are used to track financial transactions for a storeroom location. When items are 

added to a storeroom (into inventory) the account number defaults for the inventory record that is 

created. When tools are added to a storeroom (into stocked tools) the account number defaults to the 

stocked tool record that is created.  

Lead Time Calculation 

Lead time is the time between when an item is ordered and when it is received. When items are 

received, a lead time calculation is used to update the lead time on the inventory record. Lead times can 

be used to analyze vendors and determine the appropriate time to reorder items for inventory. 

Item Master Application 

The Item Master application is used define items that can be stocked in the storerooms. These items can 

be grouped into an item set. Each Organization will have its own item set. Creating item records in the 

Item Master application is done by defining the main attributes of the item, such as the commodity 

codes and the order and issue units.  
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Inventory Application 

The Inventory Application is used to store information about all aspects of inventory materials. Users 

can monitor the storeroom balance of inventory items (consumable) and tools (non-consumable) as well 

as track the condition of items and the cost of inventory stock. The Inventory application can perform 

the following tasks: 

 Search the database for inventory items and tools 

 Specify the balances of items and item costs 

 Specify the bins and lots where items are stored and view the storeroom locations 

 Issue, transfer, and return inventory items by site and storeroom location 

 Specify reorder details, such as the reorder point, the lead time, and the order unit of an 
item 

 Identify and track rotating assets that are associated with a rotating item 

 List all assets for which an item is listed as a subassembly or a spare part 
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ABC Analysis 

An ABC analysis is a technique that identifies the items that represent the greatest investment for your 

department in terms of monetary value and turnover rate. It can be used as a reporting tool for 

monitoring in stock levels of high value items in inventory. 

It is located in Inventory application >>Inventory >> Inventory tab >> ABC Analysis 

 

Inventory Costs 

In Maximo, users control the cost of inventory items and tools by using a range of costing methods. The 

default cost method is Standard cost. Average cost issues inventory so that price variations are 

reflected. Last-in-first-out (LIFO) and First-in-first-out (FIFO) costing captures and applies the cost of 

items on receipt. LIFO and FIFO costing are more precise than other costing methods. LIFO uses the 

receipt cost of items that are newest in stock while FIFO costing uses the receipt cost of items that are 

oldest in stock. 

It is located in Inventory application > Inventory > Inventory tab. 

1. Click Select Action 
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2. Click Change Cost Type 

 

3. Click Search. 
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6. Select the cost that applies. 

 

3.2. Create/Maintain Storerooms 

The Storerooms application is used to add new storeroom locations to the database and multiple 

storerooms can be created per site with no limit to the number of storerooms that can be setup in the 

system. Inventory storerooms are the places where inventory items are stored in and issued from.  

Verify if Storeroom Exists 

Before creating a new storeroom, users should first verify that the storeroom does not already exist in 

the database. This can be done by navigating to the Storerooms application using the Go To menu. Once 

in the Storerooms application on the List tab, pressing the Enter key on the keyboard or selecting the 

Reload button on the screen will display a list of all available storerooms for the users’ site. If more 

storeroom records are available than can be displayed on one page, the arrow icons can be used to 

scroll through the additional pages. 

 

On the List tab, there are four columns displayed: 

 Location – The storeroom name is a link to the Storeroom tab for the selected storeroom 

 Description – The short description for the storeroom location 

 Site – The site with which the storeroom is associated 

 Add to Bookmarks – The Add to Bookmarks icon allows users to quickly navigate to a page 
using the Bookmarks command 
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The list of records on the List tab can be sorted by clicking the column title links and filtered by entering 

text into any of the available fields at the top of each column. Additional searchable fields can be 

accessed by clicking the Advanced Search button. Entering text into the filter fields requires an exact 

match in order to return records. For example, entering “dep” into the Location filter field will not 

return location records that contain the word “department” even though the name contains the search 

string. However, the filter fields also allow the use of a wildcard character (*) to represent any additional 

characters. In the previous example, entering “dep*” into the Location filter field will return all records 

that contain a word that begins with “dep” so records that contain the word “department” would be 

displayed. The Clear Filter Fields icon can be used to remove all text from the filter fields. 

 

Create New Storeroom 

Once it has been determined that the storeroom does not exist, then one can be created by clicking the 

New Storeroom icon at the top of the screen. This will take the user to the Storeroom tab with a new, 

blank storeroom record ready for entry. On the storeroom record, the user enters information into the 

required and optional fields. The required fields for a new storeroom are the Location and GL Control 

Account fields. The rest are optional but can be useful for tracking or reporting. 

 

The available fields on the storeroom record are: 

 Location – Enter a name for the storeroom that will identify it in the system 

 Location Description – Enter a description of the location 

 GL Control Account – Enter the default GL account that Maximo applies to items in this 
storeroom during GL transactions such as issues, returns, receipts, transfers, orders, and 
adjustments 

 Cost Adjustment Account – Enter the account that tracks changes in either the average 
price or the standard price from manual inventory price adjustments. These changes result 
from using the Adjust Average Cost and Adjust Standard Cost actions, respectively 
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 Receipt Variance Account – Enter the debit account used to track the variance between 
Purchase Order (PO) and Invoice exchange rates. This account contains the differences 
between the inventory standard cost and the receipt cost (specific to the storeroom) for any 
items in the associated storeroom location and is used for standard costing only 

 Purchase Variance Account – Enter the account used to track fluctuations in purchase costs 
for items (or the variance between PO and original Last and Standard price) 

 Recent Lead Time Weight in % – Enter the weight in percent given to the most recent 
receipt of an order. Users may want to give the most recent record more (or less) 
importance in the calculation of lead time 

 Ship to Labor – Enter the labor code to ship items to when reorders are processed for this 
storeroom 

 Ship to Address – This field is auto populated with the site defaults, but can be modified, if 
necessary. Enter the address code to ship items to when reorders are processed for this 
storeroom 

 Bill to Labor – Enter the labor code for billing when reorders are processed for this 
storeroom 

 Bill to Address – This field is auto populated with the site defaults, but can be modified, if 
necessary. Enter the address code for billing when reorders are processed for this 
storeroom 

 Inventory Owner – Enter the Person code (User ID) of the user responsible for the inventory 
in the storeroom 

 Shrinkage Account – Enter the credit account used when manually adjusting the inventory 
quantity. The transaction is positive when the actual inventory quantity is greater than the 
Maximo-calculated current balance 

 Invoice Variance Account – Enter the debit account used to track variances in the price 
between receipt and invoice for this storeroom. This transaction is positive when the invoice 
line cost is greater than the receipt cost 

 Currency Variance Account – Enter the account that contains the differences between the 
PO price and the invoice price that result from changes in the exchange rate 

 Tool Control Account – Enter the debit account used for capitalized tools 

 Default Storeroom – Check this box if the storeroom is the default storeroom for the site. If 
this box is checked, Maximo reserves items for this storeroom if a job plan or work order 
does not specify a storeroom 

 Use in PO/PR – Check this box if the storeroom can be used to supply and reserve inventory 
items and tools for use with internal purchase requests and internal purchase orders 

Save the New Storeroom Record 

Once data entry is complete for the new storeroom record, the user clicks the Save icon to save the 

record in the system. At this point, the Location field becomes read-only and cannot be modified. 
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Storeroom Modification 

Storeroom records can be modified by navigating back to the Storerooms application and selecting the 

storeroom on the List tab. Fields that have a gray background are read-only and cannot be modified. 

Sections that contain rows have a Trash Can icon on the right side of the screen that allows users to 

delete the row from the list. If changes are made, clicking the Save icon will commit the changes to the 

database. 

View Items in Storeroom 

Users can view a read-only list of the items available in the selected storeroom by clicking on the Items 

tab. This tab displays items, descriptions, cost, and current balance (in stock) information. 
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ACTIVITY 1.3 

Create a New Storeroom Record 

Scenario 

You need to create a storeroom in Maximo for your department. It will be the default storeroom for 

your site and other sites may need to purchase items from your inventory. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 

Steps 

A. Verify that the storeroom does not already exist in the database. 

1. At the top of the screen, click Go To. 

2. Click Inventory > Storerooms. 

3. In the Storerooms application, on the List tab, click the Reload icon. The list of storerooms is 
displayed. 

4. Scroll through the list of available storerooms to see if one exists for your training 
department. 

5. In the Location filter field, enter tr room*. 

 

6. Press Enter. No rows are displayed. 

B. Create a new storeroom record. 

1. Click the New Storeroom icon at the top of the screen. A blank storeroom record is 
displayed. 

2. In the Location field, enter TR ROOM ##, where ## is your student number. 

3. In the Description field, enter Training Storeroom ##, where ## is your student number. 

4. In the GL Control Account field, enter MAX-TRAIN1. 

5. In the Cost Adjustment field, enter MAX-TRAIN1. 

6. In the Receipt Variance Account field, enter MAX-TRAIN1. 

7. In the Purchase Variance Account field, enter MAX-TRAIN1. 

8. In the Shrinkage Account field, enter MAX-TRAIN1. 

9. In the Invoice Variance Account field, enter MAX-TRAIN1. 

10. Check the Default Storeroom checkbox. 

11. Check the Use in PO/PR checkbox. 
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12. Click the Save Storeroom icon at the top of the screen. 

 

C. Verify that the record has been created. 

1. Click the List tab. 

2. Click the Reload icon. 

3. In the Location field, enter tr room*. 

4. Press Enter. The storeroom you created will be displayed in the records. 

 

5. When you are finished, click Start Center to return to the Home Page. 

3.3. Create/Maintain Item Master 

The Item Master application stores records for all the items in the database. Once an item record is 

created in the Item Master application it can be added to a storeroom. The tabs available in the Item 

Master application work similarly to the tabs in the Storerooms application. Selecting an item record on 

the List tab, will determine what information is displayed on the Item, Storerooms, and other tabs. For 

example, when selecting a record on the List tab, switching to the Item tab will display the details for 

that record (some of which can be modified), and switching to the Storerooms tab will display all of the 

storerooms that currently stock the item. 

Verify if Item Exists 

Before creating a new master item record, users should first verify that the item does not already exist 

in the database. This can be done by navigating to the Item Master application using the Go To menu. 

Once in the Item Master application on the List tab, pressing the Enter key on the keyboard or selecting 

the Reload button on the screen will display a list of all available items in the database. If more item 
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records are available than can be displayed on one page, the arrow icons can be used to scroll through 

the additional pages. 

 

On the List tab, the columns displayed include: 

 Item – The item name is a link to the Item tab for the selected item 

 Description – The short description for the item 

 Object - Represent object of expenditure. Advantage Chart of account element. 

 Rotating? – Specifies whether the item is a rotating asset 

 Kit? – Specifies whether the item is a kit item that contains a collection of items that can be 
issued together as a single item 

 Status – The current status of the item, options include: Active, Pending, Planning, and 
Obsolete 

 Add to Bookmarks – The Add to Bookmarks icon allows users to quickly navigate to a page 
using the Bookmarks command 

The list of records on the List tab can be sorted by clicking the column title links and filtered by entering 

text into any of the available fields at the top of each column. 
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Create New Item 

Once it has been determined that the item does not exist then one can be created by clicking the New 

Item icon at the top of the screen. This will take the user to the Item tab with a new, blank item record 

ready for entry. On the item record, the user enters information into the required and optional fields. 

The only required fields for a new item are the Item and Lot Type fields. The rest are optional but can be 

useful for tracking or reporting. 

 

The available fields on the item record are: 

 Item – This field will be auto generated by the system with a three digit agency code prefix 

 Item Description – Enter a description for the item 

 Commodity Group – Enter or select the commodity group, or product category, associated 
with the item 

 Commodity Code – Enter or select the commodity code associated with the item 

 Part Type Code – Enter or select the part type code for the item 

 Parts Usage Code – Enter the parts usage code for the item 

 Special Handling Instructions – Enter any special instructions that are important for proper 
handling of the item, such as Fragile 

 Meter Group – If the item is a rotating item, enter the meter group, or category of meters, 
to which the meter applied to this item belongs 

 Meter – If the item is a non-rotating item, enter the meter associated with the item for 
which a reading is to be recorded when this item is issued as an asset 
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 Lot Type – Specify whether the item is tracked by lot (LOT) or not (NOLOT). Typically, LOT is 
used for items that have an expiration data and is able to be assigned a lot number upon 
receipt. This field defaults to NOLOT 

 MSDS – Enter the Material Safety Data Sheet number issued by the Occupational Safety and 
Health Association (OSHA) 

 Item Set – This field will default and cannot be modified since only one item set can be 
assigned to an organization 

 Status – This field will default to pending and cannot be modified during item creation 

 Order Unit – Enter or select a unit of measure used when ordering the item 

 Issue Unit – Enter or select a unit of measure used when issuing the item from a storeroom 

 Maximum Quantity Issued – Enter the total maximum quantity that can be issued to an 
asset 

 Hazardous? – Check this box if the item is a hazardous material 

 Rotating? – Check this box if the item is a rotating asset which is tracked by item number 
and individual asset number 

 Condition Enabled? – Check this box if the item has a value or worth that can be assigned 
and tracked based on its physical condition 

 Kit? – Check this box if the item is a kit item that contains a collection of items that can be 
issued together as a single item 

 Capitalized? – Check this box if the item is to be financially accounted for as a capitalized 
cost. Tools are always accounted for as capitalized costs. Capitalized items are always issued 
and returned at zero cost, regardless of the cost carried in inventory. Non-capitalized items 
are issued and returned at the standard, last, or average cost 

 Inspect on Receipt? – Check this box if the item should be held out of inventory when 
received until the purchase order receipt has been approved 

 Add as Spare Part? – Check this box if the item will be added as a spare part for the asset 
when issued, if the item is not already a spare part 

 Attach to Parent Asset on Issue? – Check this box to attach the item to the parent asset 
when the item is issued 

 Tax Exempt? – Check this box if the item is not taxable. The buyer for the organization 
determines the tax-exempt status of items, tools, and services 

There are two sections below the Item fields that can also be completed during item record creation, 

Alternate Items and Condition Codes. 

In the Alternate Items section, clicking the New Row button allows users to enter item codes that serve 

as suitable alternatives or are interchangeable with the current item or tool. This creates a one-way 

association. The associated alternate item will not display the current item as an alternate item 

In the Condition Codes section, clicking the New Row button allows users to enter or select a Condition 

Code that will track the balance and value of each item. If an item is marked as Condition Enabled, at 
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least one condition code must be added to the record. For each Condition Enabled item, one condition 

code must have a “full-value” rate of 100%. Maximo uses this condition code as the reference point to 

calculate the value for any other condition codes for the item. 

Storerooms Tab 

During item record creation, the Storerooms tab will be blank and does not require data entry. 

Vendors Tab 

Adding vendors for an item on the Vendors tab is optional but recommended. Vendors are added by 

clicking the New Row button and entering the necessary information into the fields. Multiple vendors 

can be added for one item record. The only required fields on the Vendor tab are Promised Lead Time 

(Days) and Organization and both of those fields will default when creating a record.  

 

The available fields for a vendor are: 

 Vendor – Enter or select a valid vendor from which this item is received 

 Manufacturer – Enter or select a valid manufacturer of the item for a particular vendor 

 Manufacturer Part Number – Enter the manufacturer part number if known 

 Model – Enter the primary vendor’s model number for the item 

 Catalog # – Enter the vendor’s catalog or part number for the item 

 Promised Lead Time (Days) – Enter the promised delivery lead time from the vendor for this 
item and this specific manufacturer, model, and catalog number. This field defaults to 0 but 
can be changed 

 Tax Code – Enter or select the tax code for this vendor. This field defaults to the tax code of 
the vendor in the Companies application if it exists 

 Currency – This field is used for currency conversion but is grayed out 

 Default Vendor? – Check this box if the current vendor is the default vendor for a given item 
in an organization 
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 Disqualified Vendor? – Check this box if the vendor is disqualified from being used on new 
Purchase Requests, Purchase Orders, Request for Quote, Invoices, or any other application 
that references vendors 

 Last Price – Enter the last price received from the vendor for this item and this specific 
manufacturer, model, and catalog number 

 Last Order Date – Enter or select the last date the item was ordered from this vendor 

 Order Unit – Enter or select the unit of measure associated with the vendor’s bid price for 
this item and this specific manufacturer, model, and catalog number 

 Catalog Web Page – Enter the Internet address for this catalog item on the vendor’s web 
page 

 Tax Exempt? – Check this box if the item is not taxable. The buyer for the organization 
determines the tax-exempt status of items, tools, and services 

 Organization – Enter or select the organization for this vendor. This field defaults to the 
users’ current organization 

 Site – Enter or select the site associated with this vendor 

Specifications Tab 

The Specifications tab is used to classify the item according to the classifications that have been setup in 

the system. This process includes populating the attributes that are associated with that classification. 

The Detail Menu icon next to the Classification field allows users to select a classification for the item. 

Selecting a classification will populate the Class Description field and add the associated attribute rows 

to the Specifications section below. The attribute rows added depend on the chosen specification, and 

rows can be added or deleted as necessary for the item. 

Each attribute will have a name and description, along with a Data Type which defines what can be 

entered for the attribute. For example, a Material attribute may allow an Alphanumeric Value to be 

entered or selected to describe the material while a Size attribute may allow a Numeric Value and a Unit 

of Measure to be entered or selected. 

Item Assembly Structure Tab 

The Item Assembly Structure tab allows users to create items that are lists of parts or subassemblies. 

These items are called Kits. Kits consist of items which are always issued together. One item is the 

parent item for one or more children items in the Kit. For example, a Kit called School Supplies may 

contain 5 pencils, 5 pens, 5 markers, 10 crayons, 1 glue stick, 1 pair of scissors, and 50 sheets of paper. 

To add items to a Kit, on the Item Assembly Structure tab for the master item that will contain the list of 

parts, in the Children section, the user clicks the New Row button and enter the necessary information 

into the following fields: 

 Item – Enter or select the item code 

 Quantity – Enter the number of this item in the Kit 
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 Remarks – Enter any comments associated with the item as it relates to the Kit 

Save the New Item Record 

Once data entry is complete for the new item record, the user clicks the Save icon to save the record in 

the system. At this point, the Item field becomes read-only and cannot be modified. 

 

Item Status 

In order for an item to be usable, it must have a Status of Active. The Status field cannot be changed 

when creating the item record. The Status can only be changed by using the Select Action menu at the 

top of the screen. In order to use the Select Action menu, the list of items must first be filtered to only 

show a few records and the Select Records checkbox enabled to allow selecting a specific record.  

One way to filter the list for this purpose is to set the Status field filter to “=PENDING”. This will show 

any newly created items in Pending status in the list.  

 

Then select the Select Records checkbox which will display the checkboxes next to each record in the 

list. Find the Pending record that you want to change to Active and check the box for that record. 

Multiple records can be selected and modified simultaneously using this method. The system will warn 

users that they are about to modify multiple records.  

 

The Select Action menu allows users to choose Change Status. This will display the Change Status dialog 

box with three fields. Select the New Status of Active from the dropdown menu. It is important to note 

that if the item has previously been added to a storeroom, it is recommended to select the Roll New 

Status to Organizations and Inventory checkbox.  
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It is also recommended to enter a note in the Memo field that describes the reason for the status 

change. The status change will take place when the user clicks the OK button. 

 

Item Modification 

Item records can be modified by navigating back to the Item Master application and selecting the item 

on the List tab. The Item, Vendors, Specifications, and Item Assembly Structure tabs have fields or rows 

that can be modified. Fields that have a gray background are read-only and cannot be modified on the 

page. Sections that contain rows have a Trash Can icon on the right side of the screen that allows users 

to delete the row from the list. If changes are made, clicking the Save icon will commit the changes to 

the database. 

View Storerooms That Contain an Item 

Users can view a read-only list of the storerooms that contain the selected item by clicking on the 

Storerooms tab. This tab displays storeroom, cost, current balance (in stock), bin, status, and site 

information for the item. 

  



MAXIMO | Inventory Managment 

39 

ACTIVITY 1`.4 

Create a New Item Record 

Scenario 

You need to create an item in Maximo in order to use the item throughout the organization. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 

Steps 

A. Verify that the item record does not already exist in the database. 

1. At the top of the screen, click Go To. 

2. Click Inventory > Item Master. 

3. In the Item Master application, on the List tab, click the Reload icon. The list of items is 
displayed. 

4. In the Item filter field, enter tr item*. 

 

5. Press Enter. No rows are displayed. 

B. Create a new item record. 

1. Click the New Item icon at the top of the screen. A blank item record is displayed. 

2. The Item field will be auto generated. Note #: ___________________ 

3. In the Description field, enter Training Item ##, where ## is your student number. 
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4. In the Order Unit field, click the Magnifying Glass icon and select BOX. 

5. In the Issue Unit field, click the Magnifying Glass icon and select BOX. 

 

C. Add a vendor for the item record. 

1. Click the Vendor tab. 

2. In the Vendors section, click the New Row button. 

3. In the Vendor field, enter VENDOR1. 

4. Check the Default Vendor checkbox. 

5. Click the Save Item icon at the top of the screen. 

 

D. Verify that the record has been created. 

1. Click the List tab. 

2. Click the Reload icon. 
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3. In the Item filter field, enter item number from step B2. 

 

4. Press Enter. The item you created will be displayed in the records. 

E. Change the status of the item to Active. 

1. At the bottom of the list, click the Select Records checkbox. 

2. Locate the item you just created with your student number in the name and description, and 
check the box next to the item name.  

 

3. At the top of the screen, click the Select Action menu dropdown. 

4. Click Change Status. 

5. In the Change Status dialog box, in the New Status field, click the dropdown menu and select 
Active. 

6. Check the Roll New Status to Organizations and Inventory checkbox.  

7. In the Memo field, enter Activating new item. 

8. Click the OK button. 

 

9. Save entry. 

10. When you are finished, click Start Center to return to the Home Page. 
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3.4. Create/Maintain Inventory 

The Inventory application stores information about all aspects of inventory items and materials. Users 

can monitor the storeroom balance of inventory items and tools and track the condition of items and 

the cost of inventory stock. Vendor information can be stored so that items can be reordered promptly 

when the storeroom balance indicates that items need to be replenished. 

In order to create and maintain an inventory, items from the Item Master catalog are added to 

storerooms and made available for use.  

Locate Items 

The Item Master application, List tab is used to locate the items that will be added to a storeroom. There 

are two ways to select an item to add to a storeroom.  

 Use the filter fields and Select Records checkboxes to select one or more items on the List 
tab. Then click the Select Action menu to select Add Items to Storeroom. 

 Locate and select the item on the List tab to open the Item tab detail view. Then click the 
Select Action menu and select Add Items to Storeroom. 

Add Items to Storeroom 

After selecting Add Items to Storeroom, the first dialog box asks the user to choose a Site and 

Storeroom. The Site and Storeroom can be located and selected by clicking the Magnifying Glass icon. 

The Site will default to the user’s default Site.  

 

Once the Site and Storeroom fields have been completed, clicking OK will bring up a second dialog box. 
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In the second dialog box, the required fields are the Item, Issue Cost Type, and Issue Unit. Some fields 

will be grayed out if not applicable and only shown by expanding the details pane. The second dialog box 

contains the following fields: 

 Item – This field is required. This field will default to the currently selected item, but can also 
be modified at this point 

 Condition Code – Enter a condition code, if applicable 

 Lot – Enter a lot number if applicable 

 Issue Cost Type – This field is required and will default to Standard. Enter or select the issue 
cost type of an inventory item, can be Average, Standard, First In First Out (FIFO), Last In 
First Out (LIFO), or Asset. The Asset cost type can only be used for rotating items 

 Unit Cost – Enter the unit cost for the current item 

 Default Bin – Enter the unique identification number for the primary bin or storage location 
for the selected item within the storeroom 

 Current Balance – Enter the quantity of items that exist in the storeroom 

 Issue Unit – Enter or select the standard quantity by which the item is issued from the 
storeroom, such as each or roll 

 Order Unit – Enter or select the unit of order, such as each or roll 

 Consignment? – Check this box to identify the item as a consignment (owned by external 
vendors) type of item. This also displays additional consignment-only fields 

 Site – This field is displayed from the previous dialog box, but is grayed out and cannot be 
modified 

Once the data entry is complete, clicking the OK button will complete the process. Users can verify that 

the item was added to the storeroom by clicking the Storeroom tab and observing the item now listed in 

the inventory of the storeroom. 

 

Inventory Information Update 

The Inventory application in the Inventory module is used to update the information associated with 

inventory, such as reorder points. 

Each record on the List tab in the Inventory application represents a stock of the item in a storeroom. 

One item can have multiple records, one for every storeroom that contains the item. Selecting a record 

on the List tab will display the details of the record on the Inventory tab. 
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Inventory Tab 

The Inventory tab contains all of the information about the current inventory item record, including its 

location, costs, and balances (quantity). 

 

Most of the fields on the Inventory tab are grayed out and read-only. The available fields for editing 

include: 

 Default Bin – Identifies the primary bin or storage location for the selected item within the 
storeroom 

 Default Stage Bin – Identifies the default staging bin for the selected item 

 Issue Unit – Standard quantity by which the item is issued from the storeroom, such as each 
or roll 

 Requires hard reservation on use? – Specifies whether a reservation must be a hard 
reservation 

 ABC Type – Allows users to quickly identify which inventory items represent the greatest 
investment in terms of monetary value and turnover rate. The ABC Type value for an item is 
determined by running an ABC Analysis report 

 Count Frequency – Specifies the number of days between an audit or count of an inventory 
item 

 Minimum Level – Specifies the minimum quantity of inventory stock items required. When 
the stock balance reaches this quantity, the inventory items must be reordered 

 Maximum Level – Specifies the maximum quantity of inventory stock items allowed 
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The cost of inventory items is controlled by selecting a costing method. The costing method can be set 

to Standard or items can be issued at an average cost so that price fluctuations are reflected. Last-in-

first-out (LIFO) and First-in-first-out (FIFO) are costing methods that apply the cost of items on receipt. 

Both of these methods are more precise than other costing methods. LIFO costing uses the receipt cost 

of items that are the newest in stock. FIFO costing uses the receipt cost of items that are the oldest in 

stock. 

 

The quantities of items that are currently in stock are called the inventory balance. Balances can be 

determined by bin and lot level for each storeroom. If an item is stored in multiple storerooms, users 

can view balances for all storeroom locations they have access to. Inventory Balances are used to 

calculate item reorders. 

Reorder Details 

The Inventory application, Reorder Details tab is used to define the reorder points and quantities for 

orders. The key fields on the Reorder Details tab are: 

 Reorder? – Check this box to include this item in the inventory reorder process 

 Reorder Point – Enter the minimum quantity of inventory stock items required. When the 
stock balance reaches this number, the inventory items must be reordered 

 Lead Time (Days) – Enter the number of days it takes to receive the item after ordering 

 Economic Order Quantity – Enter the reorder quantity that provides that best economic 
value to the organization 
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Rotating Assets 

The Inventory application, Rotating Assets tab is used to view associated rotating assets. If the selected 

item is a rotating item, when it is received into inventory, an Asset must be assigned to it for every piece 

of inventory received. This tab is only usable for items that have been identified as rotating on the Item 

Master record. 

Where Used 

The Where Used tab is used to add the current inventory item as a Spare Part to an Asset. The New Row 

button is used to add a row with fields for Asset, Quantity, and Remarks. Selecting an asset will associate 

the asset with the item. 

ACTIVITY 1.5 

Add an Inventory Item to a Storeroom 

Scenario 

Now that you have created an item master record, you need to assign the item to your storeroom. You 

will use the Item Master application and the Select Action menu to complete the process. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 

Steps 

A. Navigate to the Item Master application. 

1. At the top of the screen, click Go To. 

2. Click Inventory > Item Master. 

3. In the Item Master application, on the List tab, click the Reload icon. The list of items is 
displayed. 

4. In the Item filter field, enter the Item number noted in 3.4 (B2). 

5. Press Enter. Your item record is displayed. 

 

B. Select the record and use the Select Action menu to add the item to a storeroom. 

1. Click the Item name link to open the Item tab with the details of the item displayed. 
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2. At the top of the screen, click the dropdown for the Select Action menu. 

 

3. Select Add Items to Storeroom. A dialog box is displayed. 

4. In the Storeroom field, click the Detail Menu arrow. 

5. Click Select Value. 

6. In the list of Storerooms, click the Location link for TR ROOM ##, where ## is your student 
number. 

 

7. Click the OK button. A second dialog box is displayed. 

C. Complete the second dialog box for Add Items to Storeroom. 

1. In the Issue Cost Type field, click the Magnifying Glass icon. 

2. Click the link for FIFO. 

3. In the Unit Cost field, 10. 

4. In the Default Bin field, enter 1. 

5. In the Current Balance field, enter 100. 
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6. Observe the Issue Unit field has a value of BOX. 

7. Observe the Order Unit field has a value of BOX. 

 

8. Click the OK button. At the top of the screen, a message appears that the items have been 
added to the storeroom. 

D. Verify that the item is now in the storeroom. 

1. Click the Storerooms tab. 

2. Observe that a record has been created for the item in your storeroom. 

 

3. When you are finished, click Start Center to return to the Home Page. 
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4. Inventory Management 

Learning Objectives 

In this lesson, you will: 

 Perform an issue, transfer, and return of inventory items 

 Set up automatic reorders and perform a manual reorder 

 Process the receipt of inventory items 

 Process a return of items to a vendor 

 Perform an inventory cycle count 

Lesson Overview 

Once an inventory has been created in Maximo, there are several important tasks involved in managing 

that inventory. This lesson focuses on the tasks that inventory managers and users will have to complete 

regularly, such as issuing, ordering, receiving, returning, and performing a cycle count on inventory. 

4.1. Issue/Transfer/Return Inventory 

Inventory items that are assigned to a storeroom are available to be used (consumed) by tasks, 

locations, people, or accounting functions through the issuing process. Items can be transferred 

between storerooms. Issued items can also be returned back to a storeroom. An inventory transaction 

record is created for every issue, return, and transfer performed in Maximo in order to be able to track 

the flow of items throughout an organization. 

Issue Inventory Items 

The Inventory application is used to issue an inventory item to a Charge record which includes: 

 Work Orders 

 Assets 

 Locations 

 Persons 
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For an item to be issued, the item must have a balance and be available to be issued. The Select Action 

menu is used to select the Issue Current Item option and the user must also choose an associated record 

from which the item was originally issued. 

 

The following fields are available for data entry depending on the type of record being issued to in the 

Issue Current Item dialog box: 

 Storeroom – Enter or select the storeroom location from which the item is issued, this field 
is required 

 Bin – Enter the unique identification number for the primary bin or storage location for the 
selected item within the storeroom 

 Quantity – Enter the quantity of the item to issue from the storeroom  

 Transaction Type – Select Issue (default) 

 Work Order – Enter or select the number which indicates the work order (WO) this item is 
issued for 

 WO Task – Only available if a work order is selected, select the work order task 

 Asset – Enter or select the asset to which the item is issued 

 Location – Enter or select the charge location for the issue 

 GL Debit Account – Enter or select the GL account to be debited as a result of the issue 
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 GL Credit Account – This field will default based on the storeroom 

 Issue To – Enter or select the person who receives the issued item and who is responsible 
for it until it is returned 

 Memo – Enter any remarks or comments associated with this issue 

 To Site – Enter the Site ID of the site to which the current item is being issued 

When data entry is complete, clicking the OK button will complete the transaction and reduce the 

Current Balance field on the Inventory tab by the issued quantity amount. 

Return Inventory Items 

Issued items can be returned by following the same steps used to issue the item and entering the 

information for the return in the fields. The Select Action menu is used to select the Issue Current Item 

option.  

The following fields are available for data entry depending on the type of record being returned from in 

the Issue Current Item dialog box: 

 Storeroom – Enter or select the storeroom location to which the item is returned, this field 
is required 

 Bin – Enter the unique identification number for the primary bin or storage location for the 
selected item within the storeroom 

 Quantity – Enter the quantity of the item to return to the storeroom  

 Transaction Type – Select Return 

 Work Order – Enter or select the number which indicates the work order (WO) this item is 
returned from 

 WO Task – Only available if a work order is selected, select the work order task 

 Asset – Enter or select the asset from which the item is returned 

 Location – Enter or select the charge location for the return 

 GL Debit Account – This field will default based on the storeroom 

 GL Credit Account – Enter or select the GL account to be credited as a result of the return 

 Issue To – Enter or select the person who is returning the item 

 Memo – Enter any remarks or comments associated with this return 

 To Site – Enter the Site ID of the site for which the current item is being returned 

When data entry is complete, clicking the OK button will complete the transaction and increase the 

Current Balance field on the Inventory tab by the returned quantity amount. 

  



MAXIMO | Inventory Management 

52 

Transfer Inventory Items 

It is possible to transfer inventory items from one storeroom to another storeroom using the Select 

Action menu and choosing Transfer Current Item. 

 

The following fields are available on the Transfer Current Item dialog box: 

 Quantity – Enter the quantity of the item that is being transferred 

 To Site – Enter or select the Site ID for the Site receiving the item 

 To Storeroom – Enter or select the Storeroom ID for the Storeroom receiving the item 

 From Bin – Enter the bin number to transfer the item from 

 To Bin – Enter the bin number to transfer the item to 

 Conversion Factor – This field will auto populate with the ratio necessary to convert the 
quantities of the received unit to the receiving storeroom’s issue unit 

 Unit Cost – This field auto populates with the default issue cost of the item in the storeroom 

 GL Debit Account – Enter or select the GL Account to be debited on the transfer. This field 
will auto populate based on the storerooms involved in the transfer 

 GL Credit Account – Enter or select the GL Account to be credited on the transfer. This field 
will auto populate based on the storerooms involved in the transfer 

 Memo – Enter any remarks or comments associated with this transfer 
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View Inventory Transactions 

Users can verify that items have been issued, returned, and transferred by navigating to the Inventory 

application, selecting the record on the List tab, using the Select Action menu from the Inventory tab 

and choosing View Inventory Transactions. This will display a dialog box with several tabs. Issues and 

returns can be viewed on the Issues and Returns tab. Transfers can be viewed on the Receipts and 

Transfers tab. Adjustment to item balances can be viewed on the Adjustments tab. 

ACTIVITY 1.6 

Perform an Issue, Return, and Transfer of Inventory Items 

Scenario 

With items now physically located in your storeroom, you are able to use the items to complete tasks or 

assign them to people in your site. You will issue an item from inventory, return an item to inventory, 

and transfer an item to another storeroom at your site. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 

Steps 

A. Navigate to the Inventory application and locate the item to be issued. 

1. At the top of the screen, click Go To. 

2. Click Inventory > Inventory. 

3. Click the Reload icon. 

4. In the Item filter field, enter number noted in 3.4 (B2). 

5. Press Enter. 

B. Perform the Issue Current Item action to issue an item. 

1. Click the Item name link to open the Inventory tab with the details of the record displayed. 

2. At the top of the screen, click the dropdown for the Select Action menu. 
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3. Select Issue Current Item. A dialog box is displayed. 

 

4. In the Quantity field, enter 4. 

5. In the GL Debit Account field, enter MAX-TRAIN2. 

6. In the Issue To field, select STUDENT30. 

7. In the Memo field, enter Issued items for testing purposes. 

8. Click the OK button. 

C. Verify the Inventory transaction history. 

1. At the top of the screen, click the dropdown for the Select Action menu. 

2. Select View Inventory Transactions. 

3. In the View Inventory Transactions dialog box, click the Issues & Returns tab. 

4. Observe the most recent Issue record is the one you just created. 

 

5. Click the OK button. 

D. Perform the Issue Current Item action to return an item. 

1. At the top of the screen, click the dropdown for the Select Action menu. 
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2. Select Issue Current Item. A dialog box is displayed. 

3. In the Quantity field, enter 4. 

4. In the Transaction Type field, click the Magnifying Glass icon. 

5. Select Return. 

6. In the GL Debit Account field, enter MAX-TRAIN2. 

7. In the Issue To field, select STUDENT30. 

8. In the Memo field, enter Returned items from testing. 

 

9. Click the OK button. 

E. Verify the Inventory transaction history. 

1. At the top of the screen, click the dropdown for the Select Action menu. 

2. Select View Inventory Transactions. 

3. In the View Inventory Transactions dialog box, click the Issues & Returns tab. 
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4. Observe the most recent Return record is the one you just created. 

 

5. Click the OK button. 

F. Perform the Transfer Current Item action to transfer an item. 

1. At the top of the screen, click the dropdown for the Select Action menu. 

2. Select Transfer Current Item. A dialog box is displayed. 

3. In the Quantity field, enter 20. 

4. In the To Storeroom field, enter FOAMHQ. 

5. Observe that the other required fields have been auto populated. 

6. In the Memo field, enter Transferred to testing storeroom. 

 

7. Click the OK button. 

G. Verify the Transfer transaction completed. 

1. At the top of the screen, click the dropdown for the Select Action menu. 

2. Select View Inventory Transactions. 
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3. Observe the most recent Transfer record is the one you just created. 

 

4. Click the OK button. 

5. When you are finished, click Start Center to return to the Home Page. 

4.2. Order/Reorder Inventory 

Inventory items will need to be replenished as they are used and the stock is depleted. Thresholds can 

be set in Maximo to make the process of tracking orders and reorders easier. 

Automatic Reorder 

Most of the time, inventory will be reordered through the automatic reorder process. When the balance 

of an item for an inventory record falls below the Reorder Point threshold, the automatic reorder 

process begins based on the fixed task schedule defined for the storeroom and determines the optimal 

amount of items to reorder based on the other information in the system.  
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When the Reorder Details tab is configured for an inventory record in the Inventory application, the 

Reorder Point, Safety Stock, and Economic Order Quantity fields are used to generate a reorder. The 

process also takes into account reservations and existing receipts. 

 

This process generates the Purchase Order (PO) that can be viewed in the Purchasing > Purchase Orders 

application. It is also possible to ignore the reorder point and force a reorder of an item manually. 

Manual Reorder 

A manual reorder can be performed at any time, regardless of Current Balance and Reorder Point field 

information. A manual reorder is performed from the Inventory application by locating the inventory 

record to be ordered and using the Select Action menu to choose Reorder > Reorder Items.  
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In the Reorder Items dialog box that appears the following fields are available: 

 Additional Lead Time (Days) – Enter an allowance for extra lead time in days 

 Ignore Reorder Point? – Check this box to indicate that the reorder point can be 
disregarded when generating order quantities 

 Consider Contracts When Creating PRs/POs? – Check this box to enable the reorder process 
to consider agreement purchase orders when creating PRs/POs 

 Include Soft Reservations? – Check this box to include soft reservations when selecting 
items for reorder 

 Reorder Direct Issue Items and Services? – Check this box to indicate that direct issue items 
can be reordered for all work orders 

 All Items in Storeroom? – Check this box to reorder all of the inventory items in the selected 
storeroom 

 Run in Background Mode? – Check this box to run the reorder process in the background 

 E-mail Address Notification – Enter the email address of the person who receives the 
reorder notification 

After the fields are complete, the user can click the Preview button or the Run Reorder button. The 

Cancel button is used to discard the reorder. It is recommended to use the Preview button to view the 

calculated reorder quantities for each item being reordered. If more or less than the calculated Reorder 

Quantity is actually needed, the field can be changed in the Preview displayed before the reorder is 

processed. After the Preview is updated (if necessary) the Reorder Report button can be used to view or 

print a PDF with the information. When the Run Reorder button is clicked, the manual reorder process is 

completed. 

Users can verify that the Purchase Order (PO) was generated by the manual reorder process by 

navigating to the Purchasing > Purchase Orders application and sorting the list in descending order. The 

recently generated PO will be at or near the top of the list.  

Note: For training purposes, POs are generated with approved status. 
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ProcureAZ Integration 

When a PO is generated through the reorder process (manual or automatic) and approved in Maximo, 

PO summary report will be distributed to ProcureAZ user. A ProcureAZ user will create the Requisitions 

and Purchase Orders in ProcureAZ. When an approved PO has been processed in ProcureAZ; the 

integration will pass the approved PO back to Maximo.  

Refer to Appendix B to view flow charts. 

Once the Purchase Order has been received in Maximo, users can view the item PO information on the 

inventory item record using the View Inventory Transactions action in the Select Action menu. 

ACTIVITY 1.7 

Set Up Automatic Reordering and Create a Manual Order 

Scenario 

You want to maintain a month’s worth of supplies of an item in your storeroom using an automatic 

reorder threshold to maintain a minimum balance. When extra items are needed, you will have to 

create a manual order for the item. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 

Steps 

A. Navigate to the Inventory application. 

1. At the top of the screen, click Go To. 

2. Click Inventory > Inventory. 

3. Click the Reload icon. 

 

B. Locate the inventory record in the List tab. 

1. In the Item filter field, enter Item number noted in 3.4 (B2). 

2. Press Enter. 
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3. Click the Item name link from your storeroom created in Activity 3.3, Step B to open the 
Inventory tab with the details of the record displayed. 

4. Click the Reorder Details tab. 

 

C. Update the information on the Reorder Details tab. 

1. Verify that the Reorder checkbox is checked. 

2. In the Reorder Point field, enter 150. 

3. In the Economic Order Quantity field, enter 50. 

4. In the Primary Vendor field, use the pick arrows and Select Value to select VENDOR1. 

5. Click the Save icon. 

 

D. Create a manual order. 

1. Click the dropdown for the Select Action menu. 

2. Select Reorder > Reorder Items. 
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3. Check the Ignore Reorder Point checkbox. 

4. Un-check Run in Background Mode checkbox.  

 

E. Preview the manual order and update the quantity. 

1. Click the Preview button. 

2. In the Reorder Item Detail dialog box, in the Reorder Quantity field, change the number to 
20. 

3. Click the Reorder Report button. A new tab opens with the Report Viewer displayed. 

4. Review the information on the report. 

5. Close the Internet Explorer tab. 

6. In the Reorder Items Detail tab, click the Run Reorder button. 
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7. Purchase order is generated, note PO # ______________________ 

8. Click OK. 

 

F. Verify the Purchase Order was generated in the Purchase Orders application. 

1. At the top of the screen, click Go To. 

2. Click Purchasing > Purchase Orders. 

3. Click the Reload icon. 

4. In the PO filter field, enter the PO number you wrote down in the last step (E7). 

5. Click on the PO # link and review your manual reorder. 

 

Note for training purposes PO is generated in Approved status.  

6. When you are finished, click Start Center to return to the Home Page. 
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4.3. Receiving Inventory Items 

When items are received to a storeroom, the Purchasing > Receiving application is used to record the 

receipt. 

Figure 1: Receiving Inventory (IM-TB-004A) 

 

Receiving Application 

In the Purchasing > Receiving application, the List tab displays the Purchase Orders (POs) that have been 

issued and their current status. The PO column identifies the Maximo PO number and the PAZ PO 

column identifies the ProcureAZ PO number. Automatically generated POs will have a Description that 

says when it was generated. Manually generated POs will have the user-entered Description. 

 

The PO Status column will display where in the ProcureAZ integration process the PO currently sits, 

based on what approval stage it is in. The Receipts column will display the status of receipts processing, 

either None, Partial, or Complete. A record with a Receipts value of None can be updated to Partial or 

Complete by selecting the record (clicking the PO number link) and updating the Material Receipts tab 

or Service Receipts tab for each line on the PO with the quantity received.  
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Material Receipts 

The Material Receipts tab will display the details of the PO but not the items that were ordered. Users 

process items received by clicking the Select Ordered Items button.  

 

In the Select Ordered Items dialog box, users can enter information into the following fields: 

 Packing Slip – Enter the packing slip number for the receipt 

 Quantity Due – Enter the quantity of the item that was received in the shipment. Defaults to 
the amount currently outstanding to be received 

 Remarks – Enter any comments about the receipt 

 

Check the box on the left for the items when finished, then click OK to add the information to a row on 

the Material Receipts tab. If the information was entered incorrectly, the row can be deleted by clicking 

the Trash Can icon on the right side of the row. When all rows have been successfully entered, clicking 

the Save icon at the top of the screen will save the receipt and update the storeroom balance and 

inventory record in the Inventory application.  
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Inspection Status 

If the PO line item requires an inspection, the user manually performs an inspection. Upon completion, 

the user selects Change Inspection Status from the Select Action menu and enters the Quantity 

Accepted, Reject Quantity, and optionally a Reject Code and clicks OK. Finally, the record is saved using 

the Save icon. 

When inspected items are rejected, they are returned to the vendor by selecting the Select item to 

Return button.  

ACTIVITY 1.8 

Process the Receipt of Inventory Items 

Scenario 

An order has been received and you need to unpack the order and process the receipt of items in the 

Receiving application. All of the items were received in good condition and will be marked as received. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 

Steps 

A. Navigate to the Receiving application. 

1. At the top of the screen, click Go To. 

2. Click Purchasing > Receiving. 

3. Click the Reload icon. 

B. Locate the Purchase Order in the List tab. 

1. In the PO filter field, enter the PO # from Activity 4.2. 

 

2. Click the PO link to view the Material Receipts tab for the selected record. 

C. Process the Receipt of the ordered items. 

1. Click the Select Ordered Items button. 

2. Click check box next to the item. 
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3. Click the value in the Quantity Due field. Change it to amount lower than available (partial 

receipt). 

 

4. In the Packing Slip field, enter Training PS. 

5. Press Enter. 

6. Observe that a row was added to the Material Receipts list for the PO. 

7. Click the Save icon. 

8. When you are finished, click Start Center to return to the Home Page. 

4.4. Return Inventory to Vendor 

Inventory items that need to be returned to the vendor are processed through the Purchasing module, 

Receiving application in Maximo. 

Return Items to Vendor 

The process of returning items to a vendor is completed through the Receiving application. Only items 

that have been processed and received on a PO line can be returned. For example, if 20 items were 

requested, ordered and received, the user would first complete the receipt of all 20 items and save the 

record. Then, the user would click the Select Items for Return button and specify the quantity of items 

to be returned to the vendor out of the amount received. 

ACTIVITY 1.9 

Return Inventory Items to a Vendor 

Scenario 

Some of the items received in the last shipment are defective and need to be returned to the vendor. 

During the receiving process you will make the necessary changes to the Purchase Order receipt in the 

Receiving application. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 
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Steps 

A. Navigate to the Receiving application. 

1. At the top of the screen, click Go To. 

2. Click Purchasing > Receiving. 

3. Click the Reload icon. 

B. Locate the Purchase Order for the last shipment. 

1. In the PO filter field, enter the PO # from Activity 4.2. 

 

2. Click the PO link to view the Material Receipts tab for the selected record. 

C. Specify the quantity of items to be returned to the vendor. 

1. Click the Select Items for Return button. 

2. Select the checkbox in front of the item to be returned. 

3. In the Quantity to Return field, enter 2. 

4. Click the OK button. 

 

5. Observe that a row was added to the Material Receipts list for the PO with a Type of Return. 

6. Click the Save icon. 

 

7. When you are finished, click Start Center to return to the Home Page. 

4.5. Inventory Cycle Count Procedure 

An Inventory cycle count is a process that checks the physical quantity of items currently held in 

inventory storerooms against the system quantity for the items. Routine scheduling and performance of 
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inventory cycle counts helps ensure that defined procedures are being followed and that the issue and 

return of inventory items are being accurately tracked in Maximo. 

Inventory Cycle Count Report 

The Inventory Cycle Count report can be run manually or it can be scheduled to be emailed at a set 

frequency (i.e. weekly, monthly, quarterly, etc.). 

The Inventory Cycle Count report is available through the Run Reports action in the Select Action menu 

when in the Inventory application. There are dozens of On Demand Reports available in the Inventory 

application. The quickest way to locate a specific report is to type part of the description into the 

Description field and press Enter. For example, typing “cycle” into the Description filter field will display 

the Inventory Cycle Count report at the top of the list. 

 

Clicking the name of the report will open the Request Page dialog box with the available option fields for 

the report. The fields on this page are: 

 Storeroom – Enter or select the storeroom for the report to pull from 

 Site – This field will default based on the storeroom selected  

 Immediate – Select this radio button to run the report immediately 

 At this Time – Select this radio button and enter a scheduled time for the report to run 

 Recurring – Select this radio button and specify the recurrence pattern for the report to run 

 To – The Email fields are only used if scheduling the report to be run in the future, enter the 
email address for the report to be emailed to 

 Subject – The Email fields are only used if scheduling the report to be run in the future, 
enter the subject of the report email 

 Comments – The Email fields are only used if scheduling the report to be run in the future, 
enter any comments for the report email 
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 File Type – For an Email report, select the type of file to send, either a PDF (Adobe Reader) 
or XLS (Microsoft Excel) 

 Report Delivery Format – For an Email report, select the type of delivery for the report, 
either as a file attachment to the email, or a URL to the file on the internet 

Once the report has been run and opened, the report can be printed, saved, or exported to other 

formats for distribution and for the actual count to take place. 
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Inventory Count 

The person performing the inventory count will rely on the provided cycle count report for the 

assignment. The report will define what items to count by storeroom locations, bins, etc. The cycle 

count may be done using paper-based tools for tracking. The report can be printed and the quantities 

entered on the paper for later manual entry into the Inventory application. 

 

Reconcile Cycle Count Results 

When the manual cycle count is complete, the results must be entered into the system in order to 

reconcile the system expected balances with the actual physical inventory balance. This process is 

performed using the Inventory Adjustments > Physical Counts action in the Select Action menu of the 

Inventory application. 

Only authorized inventory managers will have access to the inventory adjustment function in the 

Inventory application. 

After navigating to the Inventory application and filtering the list based on the storeroom, the 

authorized user selects Inventory Adjustments > Physical Counts to begin the bulk adjustment. A 

warning message appears to inform users that they are about to perform a bulk adjustment. 
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In the Physical Count Adjustment dialog box, each record is displayed along with the Physical Count from 

the current system inventory. The Physical Count Date field should be completed with the date that the 

cycle count was performed at the storeroom. A New Count field is available for users to enter the actual 

count from the cycle count. The Memo field is available to document any additional comments about 

the discrepancy between the two counts. When the data has been entered, clicking the OK button at the 

bottom will complete the adjustment process. 

 

ACTIVITY 1.10 

Perform an Inventory Cycle Count 

Scenario 

You need to perform your regularly scheduled inventory cycle count by running the Inventory Cycle 

Count report and entering the results of the count into Maximo to update the Current Balance 

information.  

Setup 

 User is logged in to the Maximo Home Page, Start Center. 

Steps 

A. Navigate to the Inventory application. 

1. At the top of the screen, click Go To. 

2. Click Inventory > Inventory. 
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3. Click the Reload icon. 

B. Run the Inventory Cycle Count report for your storeroom. 

1. Click the dropdown for the Select Action menu. 

2. Click Run Reports. 

3. In the Reports dialog box, in the Description filter field, enter Cycle. 

4. Press Enter. 

 

5. Click the Inventory Cycle Count report link. 

6. In the Storeroom field, enter FOAMHQ. 

7. In the Site field, enter FOAM. 
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8. Click the Submit button. 

 

9. Refer to the provided Inventory Cycle Count report for the results of the inventory count 
assignment. 

C. Perform a Physical Count adjustment using the provided Inventory Cycle Count Report information. 

1. Click the dropdown for the Select Action menu. 

2. Click Inventory Adjustments > Physical Count. 

 

3. In the warning dialog box that appears, click OK. 

4. In the Physical Count Adjustment dialog box, click the Filter arrow to expand the filter row. 

5. In the Item filter field, enter the first item code from the provided cycle count results. 

6. Press Enter. 

7. In the New Count field, enter the quantity from the ‘actual’ count results. 



MAXIMO | Inventory Managment 

75 

8. Click OK. 

 

9. In the System Message pop up window, observe the message that the Physical count has 
been adjusted. Click Close. 

 

10. When you are finished, click Start Center to return to the Home Page. 
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5. Self Service Requisitions 

Learning Objectives 

In this lesson, you will: 

 Create a Self-Service Requisition 

 Issue an Inventory Item to a Self-Service Requisition 

Lesson Overview 

The Self Service module in Maximo allows users to register themselves in the system in order to gain 

access to the applications in the Self Service module: Desktop Requisitions and Service Requests. 

Registered users can then create and view records without the assistance of an administrator or service 

desk agent. This lesson will cover the Self Service module Desktop Requisitions application which is used 

to create and view the status of purchase requisitions.  

5.1. Create a Self-Service Requisition 

Within the Self Service Desktop Requisitions module, the Create Requisition application is used to create 

a desktop requisition to search for and order items from either an internal source, such as a company 

storeroom, or an external vendor. 
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Create Requisition 

The Create Requisition application will display a new requisition that can be completed by the Self 

Service user. Requisitions created through this application will have an automatically generated 

requisition number. Users can enter a description of the requisition, enter a date that the items are 

needed, and change the priority of the requisition. Users should enter the GL account information. 

 

Add Items 

When the general information has been completed for the requisition, click Continue to begin adding 

line items to the requisition. To specify a new line item, click New Row and select an item from picklist. 

Multiple line items can be added to the same requisition by inserting more rows. Once the necessary 

items have been added to the requisition, click Continue and then Submit to submit the requisition with 

the Waiting for Approval status.  
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View Requisitions 

Created requisitions can be viewed in the View Requisition and View Drafts applications. The View 

Requisition application is used to search for, view, and change the status of a user’s existing desktop 

requisitions. Users can only view requisitions that they created or are assigned to them. Supervisors can 

view requisitions created by or assigned to any of their employees. Draft requisitions are requisitions 

that are either incomplete or have not been submitted. 

 

ACTIVITY 1.11 

Create a Self-Service Requisition 

Scenario 

You need to create a request for the item you need out of the storeroom.  

Setup 

 User is logged in using student data card for Self-service to the Maximo Home Page, Start 

Center. 

Steps 

A. Create a new Requisition. 

1. At the top of the screen, click Go To. 

2. Click Self-Service > Desktop Requisition > Create Requisition. 

3. Note the Requisition #______________________ 
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B. Complete the Self-Service Requisition. 

1. Click Continue. 

2. Click New Row. 

3. Select an Item using the Select Value icon. 

4. In the Item filter type Item number noted in 3.4. 

5. In the Quantity field, enter 10. 

 

6. Click Continue. 
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7. Review the Requisition. 

 

8. Click Submit. 

9. Click View Details. 

10. When you are finished, click Sign Out. 

5.2. Issue Inventory Item(s) to a Self-Service Requisition 

Once a Self Service requisition has been submitted and approved, the items can be issued to the 

requisition out of the reserved items. This process is performed in the Inventory > Inventory Usage 

application. After creating a new Inventory Usage record, users select the Storeroom that will issue the 

item, select the reserved item, enter the GL Debit account information, and submit the record. 

ACTIVITY 1.12 

Issue an Inventory Item to a Self-Service Requisition 

Scenario 

You need to issue an inventory item to a self-service requisition. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 

Steps 

A. Navigate to the Inventory Usage application. 

1. At the top of the screen, click Go To. 

2. Click Inventory > Inventory Usage. 
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B. Create a new Inventory Usage entry. 

1. Click the New icon. The new Inventory Usage page is displayed. 

 

2. In the Storeroom field, enter FOAMHQ. 

3. Click Select Reserved Items. A pop-up window is displayed. 

4. Check the item to be issued and click OK. 

5. Observe that a row was added to the Usage Lines. 
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6. Click to expand the details on the line item. 

7. In the GL Debit Account field, enter MAX-TRAIN2. 

 

8. Observe that the GL Credit account defaults based on the Storeroom. 

C. Issue items out of the inventory. 

1. At the top of the screen, click the Select Action menu dropdown. 

2. Click Change Status. 

3. In the Change Status dialog box, in the New Status field, click the dropdown menu and select 
Complete. 

4. In the Memo field, enter Issue item to self-service requisition. 
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5. Click the OK button. 

D. Verify the Inventory transaction history. 

1. At the top of the screen, click the dropdown for the Select Action menu. 

2. Select View Transactions. 

3. In the View Inventory Transactions dialog box, click the Issues & Returns tab. 

4. Observe the most recent Issue record is the one you just created. 

 

5. Click the OK button. 
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6. Reporting 

Learning Objectives 

In this lesson, you will: 

 Review the process of running on-demand reports 

 Review the process of creating custom reports 

Lesson Overview 

Reports provide Maximo users with the ability to view information in many different ways. This lesson 

provides an overview of the reporting tools and features in Maximo. 

6.1. Standard Reports 

At the top of every page, between the Go To menu and the Start Center link, is the Reports menu which 

allows users to select reports by application. This is a quicker way to access all of the available standard 

reports than by navigating to the desired application first. The best way to become familiarized with the 

available reports is to browse the list and preview the reports that are displayed for each application. 

Running Reports 

For standard and saved reports, select the Reports menu at the top of the screen, browse to the 

application and locate the report in the dialog box. The list of available reports can be filtered by 

Description. Since reports are application driven, users will only see reports for the current application in 

the available reports. 
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Clicking the name of the report will bring up a dialog box that displays any required query information 

along with the scheduling and email options for the report. 
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ACTIVITY 1.13 

Run a Standard Report 

Scenario 

You want to review some of the available reports in the Inventory application that you will use on a 

regular basis. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 

Steps 

A. Use the Reports menu to select Inventory > Inventory reports. 

1. At the top of the screen, click Reports. 

2. Click Inventory > Inventory. 

B. Locate the desired report and complete the query information. 

1. In the Description filter field, enter Balance. 

2. Click the Inventory Balance report link. 

3. In the Storeroom field, enter Tr Room ##, where ## is your student number. 

4. In the Site field, enter FOAM. 
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5. Click Submit. 

C. View the report. 

1. The report opens in a new Internet Explorer tab. 

2. Observe the information on the report. 

 

3. When you are finished, close the Internet Explorer tab. 

D. Locate a second report and complete the query information. 

1. In the Reports dialog box, in the Description filter field, enter Availability. 

2. Click the Item Availability report link. 

3. In the Item field, enter the Item number noted in Activity 3.4. 

 

4. Click Submit. 

E. View the report. 

1. The report opens in a new Internet Explorer tab. 

2. Observe the information in the report. 

 

3. When you are finished, close the Internet Explorer tab. 

4. In the Reports dialog box, click Cancel to close the box. 
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6.2. Custom Reports 

Custom, or ad hoc reports, can also be created and saved for future use by inventory administrators. 

These custom reports can display any selected fields and be configured with multi-level filtering, sorting, 

and grouping of records. Custom reports can also be scheduled to run in the future or at recurring 

intervals.  

Create Report 

Custom reports can only be created by navigating to the desired application and using the Select Action 

menu to choose Run Reports. In the Reports dialog box, click Create Report to bring up the Query Based 

Report dialog box with the Style, Select, Format, and Submit tabs. 

Style 

On the Style tab, select either Summary Report or Detail Report which will determine the overall layout 

of the report. Enter a unique Report Title, and set the options for the report: 

 Public? – Check this box to make the report available to all users who can run reports in the 
application 

 Save Report? – Check this box to save the report so it can be run and edited later 

 Close Window? – Check this box to close the Query Based Report window after the report is 
submitted 
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Select 

On the Select tab, add fields from the Available fields list to the Selected Fields list or vice versa by 

selecting the arrow for each row to move. The Add All button will add all available fields to the selected 

fields list, and the Remove All button will remove all selected fields from the list. 
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Format 

On the Format tab, use the Magnifying Glass icons to select Filtering, Grouping, and Sorting fields for the 

report.  
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Submit 

On the Submit tab, any filters applied on the format tab will allow used to select a value. The report can 

be run immediately, or scheduled to run in the future. If scheduled to run, the report can be emailed to 

and the File Type and Report Delivery Format can be selected. When ready, click the Submit button to 

process the new report.  
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ACTIVITY 1.14 

Create a Custom Report 

Scenario 

After reviewing the available reports, you want to create a custom report that contains the information 

you will use to manage your inventory. You will schedule the report to run every Friday and be sent to 

your email as a PDF attachment. 

Setup 

 User is logged in to the Maximo Home Page, Start Center. 

Steps 

A. Navigate to the Inventory Application. 

1. At the top of the screen, click Go To. 

2. Click Inventory > Inventory. 

3. Click the dropdown for the Select Action menu. 

4. Click Run Reports. 

B. Create a custom report. 

1. In the Reports dialog box, click Create Report. 

2. In the Report Title field, enter Training Report ## where ## is your student number. 

3. Click the Save Report checkbox. 

 

4. Click the Select tab. 

5. In the Available Fields section, locate the Issue Cost Type field. 
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6. Click the Select Field down arrow for Issue Cost Type to add the field to the report. 

 

7. Click the Format tab. 

8. Click the Magnifying Glass icon for the first Filter On Category row. 

9. Click the Report Label link for the Storeroom field. 

 

C. Schedule the report to run every Friday at noon. 

1. Click the Submit tab. 

2. In the Storeroom field, enter Tr Room ##, where ## is your student number. 

3. In the Schedule section, select the radio button for Recurring. 

4. Click the Magnifying Glass icon for the Recurring field. 

5. Select the radio button for Every Week(s). 

6. In the Week(s) field, enter 1. 
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7. In the On Day field, select Friday. 

8. In the At Time field, enter 12. 

 

9. Click the Preview button to view the dates that the report will run. 

10. Click OK. 

11. In the Email section, in the To field, select your Student Training ID. 

12. Click Submit. 

13. In the Schedule Confirmation pop-up, click Cancel to close the box. 

 

14. When you are finished, click Start Center to return to the Home Page. 

D. Verify the Report was saved. 

1. At the top of the screen, click Go To. 

2. Click Inventory > Inventory. 

3. Click the dropdown for the Select Action menu. 

4. Click Run Reports. 

5. In the Description field, enter Training. 

6. Review Scheduling Status tab. 

7. When you are finished, click Start Center to return to the Home Page. 
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7. Asset Maintenance 

Learning Objectives 

In this lesson, you will: 

 Review the Asset module applications 

 Review the processes involved in the creation of Assets, Locations, Templates, Conditions, 
and Relationships 

 Review the processes involved in the creation of Failure Codes, Meters and Meter Groups 

 Review the processes involved in contract and warranty maintenance 

 Review the processes involved in the creation of Warranty and Service Contracts 

Lesson Overview 

The Assets module in Maximo contains applications that are designed to manage the assets that are 

owned or leased by the State and its agencies from purchase to salvage, from the beginning to end of 

their life cycle. The Asset applications work together to define every aspect of each asset and enables 

you to track their value, location, and condition throughout the organization. This lesson will examine 

many of the applications in the Assets module and their role in operations. This lesson also examines the 

Purchasing module, Companies application where companies, manufacturers, and vendors are defined 

and the Contracts module, Warranty Contracts application where warranty and service contracts are 

created and maintained. 

7.1. Create/Maintain Assets, Locations, Templates, Conditions, and 

Relationships 

Within the Assets module, there are several applications that define the available attributes used 

throughout the system, such as Locations, Conditions, and Relationships. Assets are items that are fixed 

and have a value, location, and condition that can be tracked, such as vehicles and computer 

equipment. Asset Templates are templates that reduce the amount of data entry required to create 

other assets. Relationships define a dependency or connectivity between two items or records. 

Assets 

The Assets module > Assets application is used to track physical assets, define relationships between 

assets, and manage assets throughout their life cycle. 

The Assets application is used to create and store asset numbers and corresponding information, such as 

parent, location, vendor, status, and maintenance costs for each asset. The asset hierarchy is built as an 

arrangement of buildings, departments, assets, and subassemblies. The asset hierarchy provides a 
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convenient way to roll up maintenance costs so that accumulated costs can be checked at any level, at 

any time.  

The List tab lists all assets that are currently defined for the organization by Location and Site. 

Create Assets 

From the Assets application, click the New Asset icon. The required fields for a new Asset are: 

 Asset – Enter an asset code 

 Purchase Price – Enter the purchase price of the asset 

 Replacement Cost – Enter the cost to replace the asset, this may or may not be the same as 
the purchase price 

 Budgeted –  Enter the budgeted cost of work for the year 

 

The other fields on the Asset tab are optional but allow users to define additional information about the 

asset, such as the Vendor from which the asset was purchased and the Location which can be any 

location defined for the site. The record must be saved by clicking the Save button when data entry is 

complete and before navigating to another page. 

Locations 

The Assets module > Locations application is used to specify and track locations for assets. Locations can 

be organized into logical hierarchical systems or network systems. Using hierarchies or systems of 

locations and specifying the locations for assets on an asset record provides the groundwork for 

gathering and tracking information about the history of an asset, including its performance at specific 

sites, as it is moved from location to location. With locations organized into systems, users can find a 
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location on the Drilldown page accessed from the Select Action menu and identify the assets at that 

location. 

The Locations application can be used to perform the following functions: 

 Search for locations, saved queries, and bookmarks 

 View or specify detailed information specific to a location 

 View the history of, move transactions into and out of a selected location 

 View, modify, add, or delete safety records associated with a selected location 

 Associate a meter group with a location, and add and remove meters from a location 

 Type or view the specifications for a location as recorded in the Classifications application 

 View assets at a selected location 

Create Locations 

From the Locations application, click the New Location icon. The required fields for a new Location are: 

 Location – Enter a name for the location 

 Type – Enter or select a location type, such as Courier, Holding, Labor, Operating, Repair, 
Salvage, or Vendor 

It is also a good idea to enter a short description of the location in the Description field. When data entry 

is complete and before navigating to another page, the record must be saved by clicking the Save icon. 
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Asset Templates 

The Assets module > Assets Template application is used to specify common asset information in an 

asset template that can then be applied to multiple assets. Asset templates are stored at the 

Organization level. Users can associate spare parts, meters, and data sheets with the template. Assets 

that are based on the template inherit these spare parts, meters, and data sheets. Users can associate a 

specification with the asset template on the Specifications tab. 

Preventive maintenance (PM) information can also be specified for an asset template. When the 

template is applied to existing assets or new assets, associated PMs, which are based on the master PM, 

are created for each asset. 

Asset templates can be used to create multiple assets or to update multiple existing assets. For example, 

if a pharmaceutical company purchases 100 pressure gauges from the same manufacturer, the pressure 

gauges share the following identical information: 

 Manufacturer 

 Model number 

 Description 

 Operating range 

 Accuracy 

 Specifications 

 Data sheets 

A technician could create an asset template to record all the data that is identical. The technician would 

then generate a series of asset records for the pressure gauges based on the asset template. For each 

unique asset record, the technician would only need to enter a serial number and any other differences. 

Create Asset Templates 

From the Asset Templates application, click the New Asset Template icon. The only required field for an 

Asset Template is the name of the template; however it is a good idea to enter a Description of the 

template for identification purposes. Any information that will be consistent for many asset records can 

be entered into the template, such as Asset Description, Asset Type, Manufacturer, Vendor, Usage, 

Purchase Price, or Replacement Cost. The record must be saved by clicking the Save icon when data 

entry is complete and before navigating to another page. 
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Condition Monitoring 

The Assets module > Condition Monitoring application is used to create and view measurement point 

records for assets and locations. A measurement point record defines the limits of acceptable meter 

readings for a characteristic or a gauge meter on an asset or location. Measurement points are defined 

at the Site level. 

Users can generate preventive maintenance work orders in the Condition Monitoring application. Users 

can also generate work orders with a specific job plan for assets or locations with meter readings that 

are outside the defined limits.  

Create Measurement Point 

From the Condition Monitoring application, click the New Measure Point icon. The required fields for a 

measurement point record are the unique Point number and the Meter that is associated with the 

measurement point. It is a good idea to enter a Description for the measurement point for identification 

purposes. Any necessary information for the Upper Limits and Lower Limits sections should also be 

entered. The following fields are available for both upper and lower limits: 

 Warning Limit – Enter the first alarm value 

 Action Limit – Enter the second alarm value 

 Limit PM – Enter or select the preventative maintenance that is used to generate a work 
order when a measurement is entered that is above the upper limit or below the lower limit 

 Limit Job Plan – Enter or select the job plan that is used to generate a work order when a 
measurement is entered that is above the upper limit or below the lower limit 

 Limit Priority – Enter a value for the work priority for the preventative maintenance or job 
plan 
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The record must be saved by clicking Save when data entry is complete and before navigating to another 

page. 

Relationships 

The Assets module > Relationships application is used to create records that describe the dependency or 

connectivity between configuration items. The basic terms include runs on, installed on, or contained.  

Users define and work with relationships in these ways:  

 In the Relationships application, users create the formal definitions and accompanying rules 
for relationships 

 In the Configuration Items application, users associate configuration items with each other 
using the relationships that are defined in the Relationships application 

When relationships are created, users specify several properties and rules, including these properties: 

 Directionality – The directionality of a relationship affects what is found when a user 
searches for configuration items that are based on relationships. Relationships can be 
unidirectional, such as installed on or bidirectional, such as intersects with 

 Complementarity – If a relationship is complementary, one relationship implies another 
relationship. For example, the relationship of operating system A to computer B is installed 
on. This relationship implies that the relationship of computer B to operating system A is 
installed with 
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 Cardinality – This property specifies whether multiple configuration items are allowed on 
the source and the target. For example, an operating system can be installed on many 
computers, which is a one-to-many relationship. In addition, a computer can have a one-to-
one relationship, which means that the computer runs one operating system 

 Containment – This property specifies whether there is a parent-child relationship between 
configuration items 

Create Relationships 

From the Relationships application, click the New Relationship icon. Enter a name for the Relationship 

and select a Type, either unidirectional or bidirectional. It is also a good idea to enter a Description for 

the Relationship that helps identify what it does. 

 

Relationship rules control the nature of relationships between assets. Each rule group has one or more 

lines, or sub-rules, and a source and target classification. Conditional statements can be added to the 

attributes in rules to determine which subset of attributes can be used together. 

The record must be saved by clicking Save when data entry is complete and before navigating to another 

page. 

7.2. Create/Maintain Failure Codes and Meters 

Failure Codes 

The Asset module > Failure Codes application is used to build and display failure hierarchies which are 

used to construct accurate histories of the failures that affect assets and operating locations. After 

reporting and analyzing failure trends, preventive measures can be taken. The identifier for a failure 

hierarchy is the failure class. Failure codes consist of Problems, Causes, and Remedies. Failure Codes are 

stored at the Organization level. 



MAXIMO | Inventory Management 

102 

 

Create Failure Codes 

Creating failure codes requires that the problems, causes, and remedies be created, and then structured 

and defined by a hierarchy. Failures begin with a Problem code, then a Cause for the selected Problem, 

and finally a Remedy for the selected Cause.  

From the Failure Codes application, click the New Failure Code icon. Enter a Failure Class code and a 

description for the code. The record must be saved by clicking Save when data entry is complete and 

before navigating to another page. 
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Meters 

The Assets module > Meters application is used to add or modify meter definitions. Meter definitions 

include names for the meters as well as sets of attributes that describe the meters. Meters are used to 

track asset or location performance and an asset or a location can have multiple meters associated with 

it.  

 

A meter type can be Characteristic, Continuous, or a Gauge. For Continuous type meters, the Reading 

Type can be Actual (cumulative) or Delta (incremental). For Characteristic type meters, the Domain can 

be selected from a list of valid values. For both Continuous and Gauge type meters the Unit of Measure 

can be specified or selected from a list of valid values. 

While there may be instances where the same meter is used more than once on the same asset or 

location, meters in the following applications reflect logical meters: 

 Meter Groups 

 Assets 

 Locations 

 Preventive Maintenance 

 Job Plans 

 Item Master (non-rotating) 

 Condition Monitoring 
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Meters in the applications listed above are used to track meter readings, not physical meters. When 

navigating the list of meters created in the system, the Meter tab will display the details for the meter 

and the Where Used tab will display what objects the meter has been applied to by category, such as 

Assets, Locations, Preventative Maintenance, Items, and Condition Monitoring. 

 

Create Meters 

From the Meters application, click the New Meter icon. Enter a Meter code and description for the 

meter. Select a Meter Type from either Characteristic, Continuous, or Gauge. Depending on the type 

chosen, select a Reading Type, a Domain, or a Unit of Measure, if applicable. The record must be saved 

by clicking Save when data entry is complete and before navigating to another page. 

 

Meter Groups 

The Assets module > Meter Groups application is used to define a logical grouping of meters that 

comprise a meter group. Meter groups represent a collection of meters that are used together 

numerous times.  

By creating a meter group, users can add multiple meters to an asset or to a location at the same time. 

Once a meter group is defined, users can add and remove meters from the group. Meter groups can be 

applied to assets and locations using their applications respectively. Meter groups can also be applied to 

rotating items in the Item Master application. 
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Meter groups contain a Sequence of meters. For each meter in the group, there are additional settings; 

a Meter Rollover setting for Continuous type meters, and an Average Calculation Method setting which 

is used to calculate the average meter units per day and can be chosen from either Static, All, or Sliding. 

When the Average Calculation Method is Sliding, the Sliding Window Side must also be entered. When 

the Average Calculation Method is Static, the Static Average must also be entered. 

 

Meter group information is copied to a record under the following conditions: 

 An item assembly structure containing rotating items that have meter groups is applied to 
an asset or to a location record 

 The asset or the location record includes a rotating item number that has a meter group  

 A non-rotating asset or location record is created and a meter group is specified on the 
Asset tab of the Assets application 

Create Meter Groups 

From the Meter Groups application, click the New Meter Group icon. Enter a name for the Meter Group 

and a Description which will help identify the group. Click the New Row button to add a meter to the 

group. In the Sequence field enter a number for the display order. In the Meter field, select a Meter 

from the list. Depending on the type of meter selected, enter the Meter Rollover, Average Calculation 

Method, Sliding Window Size, or Static Average if necessary. Repeat the steps, adding as many rows as 

necessary to add all the meters to the group. The record must be saved by clicking Save when data entry 

is complete and before navigating to another page. 

7.3. Companies 

Within the Purchasing module, there are many applications that work together to provide a way to 

organize vendor, contact, purchasing, and receiving information.  
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Companies 

The Purchasing module > Companies application maintains detailed information about vendors, 

manufacturers, and other companies. Vendors can have parent companies and there can be multiple 

vendor locations for a single company. Using reports, users can determine total year-to-date 

expenditures with a single organization, regardless of its location. Company information must be 

entered in the Companies application first so that other modules, such as Inventory and Purchasing, can 

access the information. As such, this application is usually configured during system launch and 

maintained as necessary by inventory purchasing managers. 

For each Company record, the Company tab displays the Company Type along with any Purchasing 

Details and Payment Details. 

 

The Contacts tab displays a list of contacts associated with the company and their contact information, if 

available. 
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The Addresses tab displays the General Information and Remit To Information for the company. 

 

The Branches tab displays any branches, or companies that fall under the current company. Company 

records for companies shown on the Branches tab would list the current company in the Parent field on 

their Company tab. 

 

7.4. Create/Maintain Contracts and Warranties 

Maximo can be used to store and maintain various types of contracts and agreements. Both Warranties 

and Service contracts can be created and associated with assets in the database. 

Warranty Contracts 

The Contracts > Warranty Contracts application is used to create and maintain warranty contracts. A 

warranty contract defines an agreement to maintain one or more assets with an outside service 

provider as a warranty for a fee or a scheduled set of payments. The contract also tracks warranty 

information for assets and locations by time or meter. 

  



MAXIMO | Inventory Management 

108 

Warranty Contracts include the Contract details, Properties, Contract Lines, Associated Assets, and 

Terms and Conditions. 

 

Service contracts 

The Warranty Contracts application can also be used to create a service contract by specifying the type 

as Service. A service contract indicates that an outside service provider maintains one or more assets as 

a service. Payment for service can be made with a single fee or with a scheduled set of payments. 

Create Warranty Contracts 

From the Warranty Contracts application, click the New Warranty Contract icon. Enter a Description of 

the contract and select the type, either Warranty or Service. If there is a Vendor associated with the 

contract, select the value for the Vendor field which will populate the address information fields. 

On the Properties tab, select any of the available options for the contract. On the Contract Lines tab, 

enter a Duration and Time Unit (i.e. 3 Years) and enter a Line Cost amount. If the Line Type is Service, 

then enter a description of the item being covered by the service contract. Enter any Coverage Percent 

or Coverage Amounts for Labor, Materials, and Tools.  

The record must be saved by clicking Save when data entry is complete and before navigating to another 

page. 

There are several steps that must be completed before the contract can be associated with an asset or 

location. 
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Authorize Sites 

The next step is to authorize a site for the contract. Using the Select Action menu, select Authorize Sites 

and select the site for which the contract will be utilized. When finished selecting sites, click the OK 

button. 

Change Status 

Once the contract has been authorized for a site, the status can be changed. Using the Select Action 

menu, select Change Status and set the status to Approved. Enter any comments in the Memo field and 

click the OK button. 

Associate Assets/Locations 

On the Associated Assets tab, in the Assets/Locations section, click New Row. Select either an Asset or a 

Location for the row and click the Save icon. 
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8. Work Orders 

Learning Objectives 

In this lesson, you will: 

 Review the process involved in the creation of Work Orders 

 Review the process involved in the creation of Activities and Tasks 

 Review the Assignment Manager application 

Lesson Overview 

Maximo can be used to create and track the work orders, activities, and tasks in an efficient way from 

assignment to completion. This lesson will explore the Work Orders and Task Management module 

applications used to manage work orders and tasks. 

8.1. Work Orders 

Work Order Tracking 

The Work Orders module > Work Order Tracking application is used to create and manage work orders 

for assets and locations. A work order specifies a particular task, along with the labor, materials, 

services, and tools needed to complete the task.  
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When creating a work order, users initiate the maintenance management process and create a historical 

record of the work requested and performed.  

It is possible to create work orders in applications other than Work Order Tracking. These include the 

Changes, Condition Monitoring, Incidents, Preventive Maintenance, Problems, Quick Reporting, 

Releases, and Service Requests applications. 
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8.2. Activities and Tasks 

Activities and Tasks 

The Task Management module > Activities and Tasks application is used to plan, review, and manage 

activities and tasks. An activity initiates the work process and creates a historical record of the work 

being performed. Activities are created in the Incidents and Problems applications accessed through the 

Select Action menu. A task is a specific unit of work on a work order. An activity is a type of work order. 

A task can be created as part of an activity or part of another work order. 

 

The Activities and Tasks application can be used to perform the following functions: 

 Change the status of activities and tasks 

 Take ownership of activities or tasks 

 Assign ownership of activities and tasks to individuals or to workgroups 

 Modify activities and tasks to reflect changes 

 View related preventive maintenance and scheduling information 

 Categorize the activities and tasks using classifications and attributes to simplify their 
management and retrieval 

 Specify, view, and modify job tasks and the labor, material, services, and tool requirements 
for work plans 
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 View, add, and delete work orders and tickets that are related to an activity or to a task 

 View follow-up records for an activity or a task 

 View and create a work log and communication entries about a record 

Assignment Manager 

The Work Orders > Assignment Manager application is used to dispatch labor and schedule work for the 

organization. 

The Assignment Manager application can be used to view the requirements that were created from the 

work plan and any unplanned work on a work order. It is also possible to add new requirements to the 

work list. 

Users can view work order assignments and associated craft, skill level, vendor, contract, and 

organization requirements. Users can specify whether to view labor that applies to specific 

requirements, or view work order requirements that fit the craft, skill level, vendor, contract, and 

organization requirements, calendar availability, or shift of displayed labor. 

If a default labor query was selected in the Labor application, the Labor section displays a filtered list of 

available labor codes. If there is no selected query, the Labor section displays all the labor in the 

database. To schedule labor codes, both a calendar and a shift must be specified on the person record in 

the People application. 

To facilitate dispatching work assignments, the Work List section is color coded to indicate work 

requirements by priority. Users can change the color choices and priority ranges to fit the business 

needs. 
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Appendix A 

TERMINOLOGY 

The terms listed below are used throughout this training guide. 

Table 1: Terminology 

Term Description 

ABC Analysis A technique that identifies the items that represent the greatest investment 
for your department in terms of monetary value and turnover rate. 

Administration 
Module 

Used to configure and maintain organizations, and groups of organizations 
called sets. 

Asset Templates Used to specify common asset information. 

Assets Items that are fixed and have a value, location, and condition that can be 
tracked, such as vehicles and computer equipment. 

Assignment 
Manager 

Used to dispatch labor and schedule work for the organization. 
 

Automatic Reorder Automatic reorder process begins based on the fixed task schedule defined for 
the storeroom and determines the optimal amount of items to reorder based 
on the other information in the system. 

Cardinality Specifies whether multiple configuration items are allowed on the source and 
the target. 

Complementarity Relationship is complementary, one relationship implies another relationship. 

Condition 
Monitoring 

Used to create and view measurement point records for assets and locations. 

Containment Specifies whether there is a parent-child relationship between configuration 
items. 

Control Accounts The general ledger control accounts are used to track financial transactions for 
a storeroom location. 

Create 
Measurement Point 

Required fields for a measurement point record are the unique Point number 
and the Meter that is associated with the measurement point. 

Directionally Relationships can be unidirectional (installed on) or bidirectional (intersects 
with). 

Failure Codes Used to build and display failure hierarchies which are then used to construct 
accurate histories of the failures that affect assets and operating locations. 

First In First Out Refers to the method of using items in the order they were received. 

Inventory 
Application 

Used to store information about all aspects of inventory materials. 

Inventory Costs The default cost method is Standard cost. Average cost issues inventory so that 
price variations are reflected. 

Inventory 
Information Update 

Used to update the information associated with inventory, such as reorder 
points. 

Inventory Module Collection of applications for inventory management. 

Item Assembly 
Structure 

Allows users to create items that are lists of parts or subassemblies. 
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Term Description 

Item Master 
Application 

Used to define the items that are stocked in the storerooms. 

Last In First Out Refers to the method of using the most recently received items first. 

Lead Time 
Calculation 

Time between when an item is ordered and when it is received. 

Locations Used to specify and track locations for assets. 

Materials Receipts Display the details of the Purchase Order but not the items that were ordered. 

Meter Groups Used to define a logical grouping of meters that comprise a meter group. 

Meters Used to track asset or location performance and an asset or a location can 
have multiple meters associated with it.  

Organizations 
Application 

Used to set up the organizations and sites that are used by the State of Arizona 
and its agencies. 

ProcureAZ Used to create and manage vendors and purchase orders. 

Receiving 
Application 

Used to process the receipt of inventory items. 

Reconcile Cycle 
Count Results 

Used to reconcile the system expected balances with the actual physical 
inventory balance. 

Relationships Used to create records that describe the dependency or connectivity between 
configuration items. 

Reorder Details Used to define the reorder points and quantities for orders. 

Return Items to 
Vendor 

The process of returning items to a vendor that is completed through the 
Receiving application. 

Rotating Assets Used to view associated rotating assets. 

Start Center Customizable Dashboard that serves as a Home Page. 

Storerooms 
Application 

Used to setup of one or more storerooms this also involves associating the 
storeroom with the General Ledger information that is used to track the 
accounting for those storerooms. 

Where Used Used to add the current inventory item as a Spare Part to an Asset. 

LIST OF ACRONYMS 

The table below lists the acronyms that are used in this training guide. 

Table 2: Acronyms 

Acronym Definition 

COA Chart of Accounts 

FIFO First in first out 

LIFO Last in first out 

OSHA Occupational Safety and Health Association 

PAZ ProcureAZ 

PO Purchase Order 

PR Purchase Requisition 

QBR Query Based Reports 
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Appendix B 

INTEGRATION APPROACH 

Maximo, ProcureAZ, and AFIS integrate at the following points: 

 Order or Re-Order via ProcureAZ 

 Issuance of Inventory items 

 Transfer between Storerooms 

 Return Stock to Vendor 

 Return of Inventory Item to Warehouse 

 Count Discrepancy 

 Establish Chart of Accounts 

 Vendor Maintenance 

Each is discussed below. 
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Order or Re-Order via ProcureAZ 
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Issuance of Inventory items 
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Transfer Between Storerooms 
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Return Stock to Vendor 
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Return of Inventory Item to Warehouse 
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Count Discrepancy 
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Establish Chart of Accounts 
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Vendor Maintenance 

 


